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Introduction

Clients & Profits X has built-in full-featured media planning, buying, and tracking
capabilities. These media functions seamlessly integrate with job tickets, job costing,
and client billing. The media system lets you build detailed broadcast, print, interactive,
and outdoor media orders based on TV, newspaper, magazine, and alternative media
buys, as well as simple media estimates. Clients & Profits X keeps a list of publications,
media companies, and stations, as well as the available ad sizes and program times that
are most commonly used. By using these lists, you can create media plans with little
rekeying. In this chapter you'll learn about:

creating lists of stations/programs and publications/ad sizes

adding broadcast and print media plans

adding and printing media estimates

making insertion and broadcast orders automatically from plans and estimates
adding and printing broadcast orders and insertion orders

tracking materials due and space closing dates

printing media plans, estimates, and reports

automatically import media buys from SmartPlus, Strata, and TAPSCAN

For help using any part of Clients & Profits X, click the @.J button from any
window to open the on-line user guide. This web-based user guide features
step-by-step instructions, explanations, tips, demonstrations, and links to FAQs,
tech notes, and tutorials from www.cnp-x.com/support. The web site is

continually updated, so it's more timely and helpful than a printed user guide.



Overview: How Clients & Profits X
Manages Media

The media functions in Clients & Profits X are designed to replace the
database or spreadsheet-based custom systems that most shops now use to
plan, buy, and track media. It doesn’t try to replace high-volume media
buying systems like SmartPlus, TAPSCAN, or Strata. Instead, it is designed
for shops that buy a relatively small amount of media—and whose planning
and analytical needs are simple.

Although it can create broadcast buys, Clients & Profits X is optimized for
print media planning, buying, and tracking. It works best in shops that
primarily buy business-to-business media, instead of consumer broadcast
media. That’s because it doesn’t import and process ratings data from
media services like Nielsen and Arbitron. Instead, you’ll set up and
maintain your own station, publication, program, ad size, and rate
information. It’s a big job to maintain these files, so it’s only practical if the
number of media plans you do is small.

There are two ways to buy media with Clients & Profits: media plans and
media estimates. Media plans are elaborate and automatically lookup ad
rates, while media estimates are simple and added manually. They both
print a professional-looking report for your client to sign, authorizing your
media buys. Otherwise, they have different purposes.

Media estimates vs. media plans

Media plans use the station and publication data (which you’ll set up) to
automate the planning process—so there’s no rekeying information from
the rate table to the media plan. Media estimates skip the planning
process—instead, you'll simply type in the details about the media buy
each time you need one. There are also specially-designed media windows
and forms for broadcast and print plans.

Media estimates, however, are free-form. You can customize the informa-
tion on media estimates as needed. Every media estimate you do could
conceivably have different labels and headings, depending on the different
kinds of media that you buy. Since there’s less to set up, creating a media
estimate is much faster than creating a media plan (which may be reason
enough to use them).

If you don’t need a planning system, or use another system (like a
spreadsheet or Tapscan) to plan your buys, consider using only media
estimates. Once the media estimate is added, it can easily create insertion
orders automatically without rekeying. This saves lots of time and effort, as
well as keeps your insertion orders more accurate.

Publications, ad sizes, and contract rates

The Publications/Ad Sizes/Contract Rates window lists the publications
you most commonly use, as well as the various ad sizes available for each
publication. Each publication can have dozens of ad sizes, each with details
about its position, commission, space close, and materials close dates.
These production specifications are carried over to the media plan and to
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media reports, for easy reference. Each publication ad size has a standard
rate. In addition, you can set up contract rates for each client. This option
lets you specify special ad sizes and rates that are only available to a client.
So when a print buy is added for a particular publication, the client’s special
rate will be used instead.

Stations, programs, and contract rates

The Stations/Programs/Contract Rates window lists the stations you most
commonly use, as well as the programs/times for each station. You can
enter a virtually unlimited number of stations. And each station can have
hundreds of different programs and times. A station can have a set of
programs, each with its rating and a standard cost. Or, you can set up
contract rates for specific programs and clients. Each client can have its
own table of contract rates for each station. So when a broadcast buy is
added for a particular station, the client’s special contract rate will be used
automatically.

Insertion orders, broadcast orders

Insertion orders can be added manually into the Insertion Order window, or
created automatically from print media plans or media estimates. When
created automatically, there’s no rekeying—the media buy’s publication, ad
name, position, cost, and other details are copied directly to the insertion
order. You can make insertion orders from media plans and estimates on
demand; the entire process takes less than a minute. Once the insertion
order is saved, you can review it, make changes, then print it for the
publication.

Broadcast orders can be added manually into the Broadcast Order window,
or created automatically from broadcast media plans. When created
automatically, the media buy’s station, rating, number of spots, and other
details are copied directly to the broadcast order. Once the broadcast order
is saved, you can review it, make changes, then print it for the station.

Interactive orders, outdoor orders

Clients & Profits X can print interactive orders specifically designed to buy
on-line advertising. Outdoor orders are designed especially for buying media
space on billboards, buildings, and other out-of-home locations. Interactive
and outdoor orders are added like print and broadcast orders; they get job
numbers and job tasks, are costed from vendor invoices added in Accounts
Payable, and can be billed in one step in Accounts Receivable.

Media estimates

If you buy mostly print media (magazines and newspapers) for your clients
and you’re planning needs are basic, use a media estimate. Adding a media
estimate is similar to adding a job: the media estimate has a number, a
client, a description, and line items just like a job has tasks.



Media Features

Feature

How it works, how it's used

Media Calendar

Clients & Profits X features an integrated media calendar. The calendar, which conveniently
appears whenever users work with media, lists upcoming space closing and material due
dates as well as user-defined calendar “tickler” entries. These scheduled entries can be
automatically e-mailed to media planners, buyers, and vendors.

Publications/ad sizes/media
companies tables

The names, addresses, and phone numbers of the most commonly-used publications and
their various ad sizes (including prices) can be set up before adding print media plans. The
information entered for each publication and ad size is copied automatically to new print
plans, saving time and reducing data-entry errors. The publications table can be updated any
time as information changes.

Stations/programs tables

The Stations table lists the name, address, and account details for hundreds of different
radio, television, and cable stations. The Times/Programs table contains descriptions and
costs of the time slots offered by each station. This information is used automatically by
broadcast media plans, and is copied to broadcast orders.

Media estimates

Simple, quick media estimates can be created for clients showing them a schedule of media
buys for any number of publications or stations. The printed media estimate looks like a job
estimate, and includes a client approval signature line. Insertion orders can be made
automatically from media estimates.

Broadcast media plans

Detailed broadcast media plans can be created that show scheduled radio, television, cable,
buys, including the number of spots, rating, cost per point, and more. Broadcast orders can
be generated directly from broadcast media plans.

Print media plans

Complete print media plans can be made that show schedule ad placements for daily
newspapers, weekly periodicals, or monthly magazines. Insertion orders can be created from
print media plans without rekeying.

Insertion orders, broadcast
orders

Orders can be created automatically from broadcast and print media plans. Orders can be
placed any time using the information already saved on the media plan, saving time and
eliminating rekeying errors. Orders are saved directly in the Media Orders table, where they
can be proofed, printed, then billed—without retyping.

Media billing

Once insertion and broadcast orders are created from media plans, they can be easily and
quickly billed. Orders can be pre-billed directly from the Insertion/Broadcast/Interactive/
Outdoor Orders window (choose Edit > Pre-bill) one-by-one, or billed together in batches by
client in Accounts Receivable. Insertion and broadcast orders remember the client’s invoice
number, so it's easy to keep track of unbilled media.

Media WIP accounting

Media accruals for work in progress are posted automatically from media billing. The net cost
of the insertion or broadcast order is used for accrual journal entries, which update a special
WIP accrual G/L account. When the media vendor’s invoice is entered, it reconciles the
actual cost of the media with the accrued cost then makes the automatic reversing entry.

Media reconciliation

In Accounts Payable, the actual number of broadcast spots or ad placements is reconciled
with the planned spots from the insertion or broadcast order. Each order keeps its own
running balance of planned cost vs. actual cost, making it easy to bill clients accurately.

Importing SmartPlus, TAPSCAN,
and Strata media buys

The built-in Media Link imports broadcast orders from MRP’s SmartPlus, TAPSCAN, and
Strata. Imported buys appear automatically in the Broadcast Orders window, where they can
be billed like other broadcast orders. A “standard media interface” lets any other media
buying system export buys to Clients & Profits X using a simple-to-program import file format.

Media Features



Overview (con’t)

Media estimates are very customizable. Each media estimate has five
column labels (e.g., publication name, issue date, close date, ad caption,
and ad size) that you can change for different kinds of media buys. You can
enter a long description, a campaign code (for post-buy tracking), a
standard disclaimer, and up to three approval names. These details appear
on the printed media estimate.

Media estimates don’t affect job
tickets until the insertion orders are

then choose Pre-bill Order from the Edit menu. The order’s details are
copied instantly to a special pre-billing invoice. The invoice is numbered
automatically. You can see pre-bill invoices on the proof list, make any
needed changes, then post them. Once posted, the pre-bill invoice
information updates the insertion or broadcast order so it can’t be billed
twice.

It’s also easy to bill many insertion
or broadcast orders at once. The
media billing option in Accounts
Receivable displays a window
listing the client’s unbilled

insertion or broadcast orders. You
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can select one, many, or all orders
for billing by clicking on the
checkbox next to the order line
item. The media billing invoice
has a different layout than regular
job billings; it shows the
publication or station, ad name, ad
size, issue date, and gross cost.

Media preferences

Your media preferences let you

Since these periods are
customizable, they can handle any
kind of time range; however, the periods you enter apply to every buy on
the media plan.

Adding media buys is like adding tasks to jobs. You'll enter the publication
or station code, which behaves like the task code. You can see the
publication’s ad sizes (or the station’s programs/times) from a pop-up
Lookup List. Double-clicking on an ad size (or program) enters it onto the
media plan. Most importantly, the rate is copied to the media buy
automatically. For broadcast buys, you’ll enter the number of times the
spot will run—and the total cost and rating points are calculated
automatically. You can add many different buys for many different
publications (or stations) onto the same media plan.

When the media plan is printed, the buys you’ve entered are grouped
together by publication (or station).

Media billing
There are two ways to bill media in Clients & Profits: pre-billing an
individual insertion (or broadcast) order or summary billing one or more

orders.

An insertion or broadcast order can be easily and quickly pre-billed directly
from the Insertion/Broadcast Order window. It’s simple: find the order,
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standardize some of the informa-
tion seen on insertion and
broadcast orders. This information,
such as the disclaimer, logo, and print copies are copied to orders
automatically to save time. You can even order media under a different
name and address, which is ideal for in-house agencies. You can customize
how insertion and broadcast orders are automatically numbered, including
entering the next order number.

Media and the General Ledger

There is no direct link between media plans and the General Ledger. Adding
a media plan doesn’t affect jobs. The job ticket is updated when an insertion
order is created from a media plan; the job task’s Net and Gross total
increases to show that you’ve ordered something. Insertion orders, like
purchase orders, don’t affect the General Ledger either. The General Ledger
is only affected when the station or publication’s invoice arrives or the
insertion is billed.

You can account for insertion orders made during the month with general
journal entries to a media G/L account. A list of insertion orders added
during the month can be printed from the Media Reports window; this total
would be added as a journal entry, then reversed next month. The difference
between the month’s insertions is your actual media cost.



The Media menu

Media Calendar @

Media Briefs (Campaigns)

Media Estimates @

Broadcast Media Plans
Print Media Plans @

Insertion/Broadcast/Interactive/Outdoor Orders

Media Traffic @

Stations @
Publications @

Media Billing Goals...

Media Link

1 The Media Calendar displays all
of the month’s space closings
(from media plans and estimates)
and material due dates (from
insertion and broadcast orders).

2 Media Briefs are like creative
briefs for media plans and
estimates. They organize the
objectives, goals, and budgets for
a client’s media buys.

3 Media Estimates are simple
summaries of the media buys that
you place for a variety of
publications and a range of dates.
It's the quickest way to show a
client all of the buys you plan to
make on their behalf.

4 Broadcast Media Plans are
used to make detailed plans of
spot tv, cable, and radio ads for a

client media campaign. Broadcast
plans can be created for any
broadcast month and can contain
buys for dozens of different
stations.

5 Print Media Plans are used to
make detailed plans for space
buys in magazines, newspapers,
billboards, and other print media.
Print plans can be created by day,
week, month, or year.

6 Insertion/Broadcast Orders take
buy details from estimates and
plans to create orders for media
vendors. Media orders can also be
added directly, bypassing the
media estimate and media plan
steps. They update jobs and
tasks, and are the start of the job
costing and billing process.

7 The Media Traffic window lists
space reservation deadlines and
dates for materials due by week
for the next four weeks.

8 The stations table lists media
stations and their times and
programs. Both are used on
broadcast media plans and orders.

9 The publications table lists
media publications and their
space buy details (such as ad
size). Both are used on print
media plans, media estimates,
and insertion orders.

10 The optional Media Billing
Goals window lets you plan a
year's worth of billings by type of
media (e.g., broadcast, interactive,
etc.) for all clients. Media analysis
reports will compare actual media
billing with these goals.
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Media Work Flow

TV / RADIO / CABLE

1.
Add stations, programs, and
client contract rates

2.
Add broadcast media plan

3.
Add media buys for broadcast
plan

4,
Print the broadcast media plan
for review

5.
Make revisions, then print the
broadcast media plan for client
approval

6.
Print station’s broadcast
worksheet

7.
Make broadcast orders

8.
Pre-bill the broadcast orders
or create a Media billing
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MAGAZINES / NEWSPAPERS

1.
Add publications, ad sizes, and client
contract rates

2.
Add print media plan

3.
Add space buys for print plan

4.
Print the print media plan for review

5.
Make revisions, then print the
print media plan for client approval

6.
Make insertion orders

7.
Pre-bill insertion orders or
create Media billing



INTERACTIVE

1.
Add media companies and
standard, client contract rates

2.
Add interactive media estimate

3.
Print the interactive media
estimate for client review

4,

Make revisions, then print the
final media estimate for client
approval

5.
Generate the interactive media
orders from the estimate

6.
Pre-bill the interactive orders
or create a media billing

OUTDOOR

1.
Add media companies and
standard, client contract rates

2.
Add outdoor media estimate

3.
Print the outdoor media esti-
mate for client review

4,

Make revisions, then print the
final media estimate for client
approval

5.
Generate the outdoor media
orders from the estimate

6.
Pre-bill the outdoor orders
or create a media billing

Media Work Flow
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Media Calendar

The Media Calendar window is a useful tool for managing media. Media calendar entries can be entered at any time to
help users remember important media-related dates, such as client presentations, vendor meetings, conferences, and
planning sessions. Double-clicking on any date in the Media Calendar window will open the Day-at-a-Glance window.
This special window shows a listing of all the calendar entries for the selected date with their priority level conveniently
color coded. To view all the details of a calendar entry, just double-click on it.
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Add Media Calendar Entry

Calendar: Media a

@ pate: [05/09/04

9:00 AM

o Action/Event: | Clignt HSA planning meeting

Description:

Client: | 10

Be sure to print your last guarter's media plans before the |a
meeting — let’s try ta increase their cable spending 30% form
the next quarter| e

Priority: | Normal |:—] o

Notify via e-mail 2 | day(s) in advance o

v

Status: | geady For Media Buys 6

Location: | Conference Room A e

@ (Cancel J( Save )

Help

Media calendar entries keep track of important media dates. Tickler entries can be
scheduled for any future date and can be automatically e-mailed when they’re due.

1 Use the calendar pop-up menu
to choose which calendar to add
the media calendar entry for.

2 Date and time tells when the
media event will happen.

3 Location describes where the
media calendar entry will happen.

4 The action/event is a short
description of the media event. It
will appear on the Media Calendar
window, so it should be meaning-
ful to other users.
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5 Use the description field to
further describe the details of the
media action/event.

6 You can determine the
importance/urgency level of the
media event using the priority pop-
up menu. In the Day-at-a-Glance
Calendar, each media event will be
designated as high, normal, or low
priority with a colored icon (red for
high, yellow for normal, and green
for low) so users can easily see the
priority level.

7 Specify an automatic lead time
warning e-mail in days prior to a
media action/event.

8 A media calendar entry can be
added for any client.

9 A status can be assigned to the
media calendar entry.

10 The added by field shows the
initials of the person who added
this media calendar entry.
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Media Calendar
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Previous Mext @ Add © Print help
find date:  09/01/04  ( Fna ) show today (@) = O

Media Department

_r September

)20 O

SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY SATURDAY
1 P 3 4
5 6 7 8 a 10 11
Client HSA planning
meeting, Clinet BAC
Media Estimate
Aporoval
12 13 14 15 16 17 18
Client ENG planning
meeting
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Client FOO planning
meeting
26 27 28 29 30
M/50002 M/50003

The Media Calendar keeps your media staff informed by letting them see at-a-glance

what important media events are fast approaching.

1 Use these toolbar buttons to
scroll through the previous and
next months of the media
calendar.

2 You can create a media
calendar entry by clicking on the
add button.

3 To get a hard-copy printout of
the media calendar, click on the
print calendar button.

4 Enter a date here to find media
calendar entries for a specific
date. To jump to today’s media

calendar entries, click on the show
today link.

5 Use the month and year pop-up
menus to choose which month of
the media calendar you want to
view. The media calendar allows
you to create entries for three
years.

6 Click on a date in the Media
Calendar window to open the Day-
at-a-Glance Calendar. This window
will allow you to view the details of
a media calendar entry, as well as
add new entries.

Media Calendar
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Media Briefs (Campaigns)

A media brief is a worksheet that the media department can use to define and document the media process your agency
follows to purchase media. It helps outline what needs to be accomplished by the media purchased; they focus on what
needs to be done to start buying media; and track the necessary, minute details of the media buying process. The media

brief can be printed with all its important planning details to be distributed to the AEs and clients.

k) Medi Briefs (Campaigne)
| S # ) F oy
&) (i o @ e ) W (R
| Add Clone  Fair  Delete  © Priot Report Pont Briel Send E-mail © Approve il Help |
ALL [ wow Y
[ Pending Campaigns |_anpmoved Campaigns, | Killed Campaigns |
e Client “Slcampaign_ Mame _ Cstarts s status
JENG ENGOOLP  1Am Energy _09/01/04 10/11/04 _Approved
BNG ENGUOZF Year End Sale 1171204 12/30/04 PENDING
HEA HSADI4R  Intracuting Stingray 09/15/04 11/15/10 Peniing
TR TEROISR  Energize Your Life 10/19/04 11/30/04 Approved
BAN BANU45F  Streaming Server Updates OL/14/05 02714705 Pending
o1 TOTOOIP  Pasitional lighting systems 12/01/00 02/15/0% an hokd

4 media briefs listed
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Use media briefs to keep the media department and the AE’s on the same page about

media planning, ordering, targeting audience, budget, etc.

1 Media briefs can be easily
added, cloned, edited, and
deleted. To add a new media brief,
click on the add button. Or use
the clone button to clone a media
brief into a new one. Cloning
copies all of the details from an
existing media brief, then lets you
edit it. To change the media brief's
details (i.e., target group,
objective, media budget, etc.),
click on the edit button. Media
briefs are flexible so they can be
edited at any time. To delete a
media brief, click on the delete
button.

Media Briefs (Campaigns)

2 To print media reports, click on
the print reports button. To print a
hard-copy printout of the media
brief, click on the print brief
button.

3 Click on a tab pane to switch
between pending media briefs,
killed media briefs, and approved
media briefs.

4 To find a media brief, enter a
client code here.

5 Media briefs are listed in order
by client. You can change the sort

order by clicking on any of the
column headings.

6 Media briefs are displayed with
their client code, campaign ID
number, campaign name, start
date, end date, and status.
Double-click on a campaign to
view its details.

7 The objective for a selected
media brief appears here for
reference.
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Add Media Brief (Campaign)

Client:
Campaign ID:
o Campaign Name:

o Start Date:

Media Rep:
Objective:

0 Details: |

Status Note:
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ENGOD3P 0

01/05/05

“There |s No Energy To Spare”
End Date: D3/31/05

Eric Ericson 6

AE: AK | Added by: MGR

Promoting service for low income residents to receive a review from Corporate Engineering Services and be eligible for upgrade

0o

energy saving devices in the PA, WV, and OH areas.

Media Recommendations "‘v"]

Daily newspapers in smaller markets

Broadcast:
Cable:
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Newspaper:
Magazine:
Qutdoor:
Interactive:

Other:

Pending client ok

(1]

® (o) =9

meDiA BunGeT: (@)

3 120,000

10,000
$ 7,500
2000

§ 139,500

Help

Add a media brief to keep track of all your important details (i.e., target age, media
schedule, supporting exhibits, etc.) for a campaign in one easy to find place.

1 Each media brief is entered for
one client only.

2 The campaign ID code is
usually a combination of the client
code and a number.

3 The campaign name should
briefly describe the campaign.

4 The start date and end date
note when the campaign was
opened and when it will close.

5 The media rep is the person
responsible for planning and

buying this campaign’s media.

6 Campaigns can be given an
optional AE. Custom reports can
analyze campaigns by AE.

7 The added by initials are the

person who added this campaign.

8 An objective can be added to
explain the primary goal of this
campaign. It appears in the
Media Brief window so it should
be clear and meaningful to other
users.

Media Briefs (Campaigns)

9 Use the details pop-up menu to
enter in the details for the
campaigns target age, target
gender, target occupation, target
lifestyle, media recommendations,
media schedule, and supporting
exhibits.

10 A media budget can be
entered for the campaign. It is
broken out by media type (i.e.,
broadcast, cable, radio, etc.).

11 An optional status can be
used to track campaigns from start
to finish using the same Status
Table as jobs.
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Media Estimates

‘5 ey Media Estimates
VO L@ & @ @® )
b R R R & O . . =
Previous MNext : Add Clone  Edit Delete : Add Buy Remove Buy @ Make Order : Print Reports Print Estimate Help
find number:  SED-133 find more @ history:  BAC0O1 3 (7)
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Date: "
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Ex8
Adv Age 11/15/37 10/29%/04 | Ad#/Caption 3 B40.00 § 840.00
| s v
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KT
(13 5 1,641.90 §1,641.90
@ Status: —— $15L.50

b
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Media Estimates

The media estimate provides a simple way to show clients how and where their ads will
be placed. There’s no limit to how many media estimates you can add for a client.

1 Use these toolbar buttons to
scroll through the previous and
next media estimates.

2 Media estimates can be easily
added, cloned, edited, and
deleted. To add a new media
estimate, click on the add button.
Or use the clone button to clone a
media estimate into a new one.
Cloning copies all of the details
and buys from an existing media
estimate, then lets you edit it. To
change the media estimate’s key
details (i.e., client, approvals,
date, commission, etc.), click on

the edit button. Media estimates
are flexible so they can be edited
at any time. To delete a media
estimate, click on the delete
button.

3 The media estimate is
incomplete without media buys.
The buys indicate exactly which
ads are running on each
publication. A single media
estimate can contain one or many
media buys from one or many
different publications. To add a
media buy to the media estimate,
click on the add buy button.

Media buys can be deleted at any
time before they are ordered (that
is, an insertion order has been
created for it). To remove a media
buy, click on the remove buy
button.

4 Insertion orders can be created
automatically from your media
estimate by clicking on the make
order button. You can make an
insertion order for one selected
space buy, or for all space buys on
the media estimate. One insertion
order will be created for each
publication.



A media estimate is added in two parts, much like adding a job ticket. First, open the
new media estimate, which includes the estimate number, client, campaign name, and
description. Next, add media buys for each time an ad will run for this estimate.

5 To print media reports, click on
the print reports button. To print a
hard-copy printout of the media
estimate, click on the print
estimate button.

6 Enter a media estimate number
here to find a media estimate. Or
use the find more link to find
media estimates by sequence,
number, client, description, date,
or campaign.

7 Use the history pop-up menu to
jump to a previously viewed media
estimate.

8 A media estimate is opened for
only one client. This would be the
client who will be responsible for
authorizing these media buys.

9 Media estimates are numbered
automatically by client, like job
tickets. The estimate number is
the combination of the client
number and its next estimate
number. You can enter any kind of
estimate number you like.

10 A media estimate can be
marked as closed after its buys
have been ordered. Placing a
media estimate on-hold makes it
inactive, but keeps it open for

future use. Closed and on-hold
orders don't appear on media
status lists and traffic reports.

11 Category is the media kind
that has been selected for the
media estimate’s vendor. It is
used on some media reports to
group media estimates together.

12 The description can contain
any kind of notes, specifications,
objectives, or strategies that
should appear on the printed
media estimate. The description is
changed by clicking on the Edit
button.

13 A media estimate can contain
dozens of individual buys, which
represent different dates in which
an ad will run. The column
headings for media buys are
customizable—each media
estimate can have different labels,
for flexibility. They can be changed
by clicking the edit button.

14 The publication code
indicates from which magazine,
newspaper, outdoor, or other
media this buy is being ordered.

15 The issue date shows when
the ad will run.

16 The ad number, caption, and
size describe the ad space that
will be ordered from this estimate.
These details appear on the
printed insertion order and the
client’s media billing.

17 Gross cost is the amount
you're charging the client for this
ad. The commission is copied
from the client, and is used to
calculate the ad’s net cost. Net
cost is the amount you'll pay the
publication for the ad.

18 If the selected media buy has
already been ordered on an
insertion order, the 10 number,
date, and actual order amount will
appear here for reference.

19 Media estimates can be
tracked from start to finish by
status on reports. The status is
optional, and is completely
customizable. It is not related to
the job production/billing status
codes.

Media Estimates
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Broadcast Media Plans
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0
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Most of the information entered on a broadcast media plan is included on the printed
broadcast plan that the client will approve. It can be revised and reprinted many times.

1 Use these toolbar buttons to
scroll through the previous and
next broadcast media plans.

2 Broadcast media plans can be
easily added, cloned, edited, and
deleted. To add a new broadcast
media plan, click on the add
button. Or use the clone button to
clone a broadcast media plan into
a new one. Cloning copies all of
the details and buys from an
existing broadcast media plan,
then lets you edit it. To change the
broadcast media plan’s key details
(i.e., client, approvals, flight dates,

Broadcast Media Plans

commission, etc.), click on the
edit button. Broadcast media
plans are flexible so they can be
edited at any time. To delete a
broadcast media plan, click on the
delete button.

3 The broadcast media plan is
incomplete without spot buys for
times and programs. A separate
spot buy should be added for each
time or program during which the
ad will run. To add a broadcast
buy to the broadcast media plan,
click on the add buy button.
Broadcast buys can be deleted at

any time before they are ordered
(that is, a broadcast order has
been created for it). To remove a
broadcast buy, click on the remove
buy button.

4 To print media reports, click on
the print reports button. Click the
print worksheet button to print the
Broadcast Worksheet which shows
the plan’s buys in detail by station
and the total number of spots,
cost, and rating for each station
and for the entire plan. To print a
hard-copy printout of the broad-



Broadcast media plans can be created for many kinds of radio, television, cable, or even
Internet-based media buys. A broadcast media plan is similar to a job ticket: it is
opened for one client, has a number to track it, can be changed many times as needed,
and printed for a client’s approval.

cast media plan, click on the print
plan button.

5 Broadcast orders can be created
automatically from your broadcast
media plan by clicking on the
make order button. You can make
a broadcast order for one selected
broadcast buy, or for all broadcast
buys on the broadcast media plan.
One broadcast order will be
created for each station.

6 Enter a broadcast media plan
number here to find a broadcast
media plan. Or use the advanced
search link to find broadcast
media plans by sequence,
number, client, namettitle, start
date, or campaign.

7 Use the history pop-up menu to
jump to a previously viewed
broadcast media plan.

8 Use the specifications link,
vendor info link, and delivery link
to add/edit/view information about
the broadcast media plan and its
vendor.

9 Each broadcast media plan is
tracked by a media plan number.
Media plans are numbered
automatically by client. Each
client has its own numbering
sequence for easy tracking. A
media plan’s number can’t be
changed. Broadcast media plans
are opened for a single client. The
client number will be copied from
the media plan to broadcast orders
and, eventually, to media invoices.
The media plan’s nameftitle

appears here for reference and is
usually a brief description of the
plan’s objective. The broadcast
plan’s flight schedule is
customizable. These are the days
on which the spots will run.

10 A broadcast media plan can
be marked as closed after its buys
have been ordered. Placing a
broadcast media plan on-hold
makes it inactive, but keeps it
open for future use. Closed and
on-hold orders don't appear on
media status lists and traffic
reports.

11 The buyer initials are copied
as the person adding the media
plan, but can be changed.

12 The broadcast media plan’s
total spots, rating, cost, and other
summary totals appear here for
easy reference. The CPP is the
cost per rating point and the CPS
is the cost per spot.

13 The campaign code is
displayed here for easy reference.
The media plan’s optional budget,
if entered, appears here.

14 The broadcast media plan’s
spot buys are listed by station.
Each spot buy contains a station
name, the time/program name
during which the spots will be
running, the length of each spot,
the number of spots, total rating
points, and the spot buy’s total
gross cost. Double-clicking on a
spot buy displays its complete
details.

15 The station is who you bought
the broadcast buy to run during a
time or program.

16 Market shows where the
broadcast buy’s spots will run.

17 Dates shows when the
broadcast buy’s spots will run.

18 The time/program field
contains the name of the time or
program the broadcast buy will
run.

19 Length describes how long the
broadcast buy’s spots will run.
Spots shows the number of times
the broadcast buy will run during
the time or program. Rating
shows what the time or program’s
rating is.

20 Gross/Each shows how much
each spot run for the broadcast
buy will cost.

21 The status field can be used to
track broadcast media plans. It
appears here for reference, but it
can be edited in the Edit
Broadcast Media Plan window.

Broadcast Media Plans
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Print media plans can be created for three kinds of periods: daily (for newspapers),
weekly (for newspapers, journals, etc.), and monthly (for magazines).

1 Use these toolbar buttons to
scroll through the previous and
next print media plans.

2 Print media plans can be easily
added, cloned, edited, and
deleted. To add a new print media
plan, click on the add button. Or
use the clone button to clone a
print media plan into a new one.
Cloning copies all of the details
and buys from an existing print
media plan, then lets you edit it.
To change the print media plan’s
key details (i.e., campaign, start
date, end date, approvals, kind,

5-18 Print Media Plans

etc.), click on the edit button.
Print media plans are flexible so
they can be edited at any time. To
delete a print media plan, click on
the delete button.

3 The print media plan is
incomplete without buys for ad
space. Space buys indicate
exactly which ads are running on
each publication during each of
the plan’s twelve months, weeks,
etc. One print media plan can
contain space buys for dozens of
different publications, or many
buys for the same publication. To

add a space buy to the print
media plan, click on the add buy
button. Space buys can be
deleted at any time before they are
ordered (that is, an insertion order
has been created for it). To
remove a space buy, click on the
remove buy button.

4 |nsertion orders can be created
automatically from your print
media plan by clicking on the
make order button. You can make
an insertion order for one selected
space buy, or for all space buys on
the print media plan. One



The print media plan is incomplete without buys for ad space. One print media plan can
contain space buys for dozens of different publications, or many buys for the same

publication.

insertion order will be created for
each publication.

5 To print media reports, click on
the print reports button. To print a
hard-copy printout of the print
media plan, click on the print plan
button.

6 Enter a print media plan
number here to find a print media
plan. Or use the find more link to
find print media plans by
sequence, humber, client, name/
title, start date, or campaign.

7 Use the history pop-up menu to
jump to a previously viewed print
media plan.

8 Use the specifications link to
view the print media plan’s details.
Use the vendor info link to view or
edit the vendor’s address. Use the
delivery info link to enter special
delivery instructions for the print
media plan. Use the periods link
to view or edit the buy periods for
the print media plan.

9 Print media plans are opened
for a single client, just like a job
ticket. The client number will be
copied from the media plan to
insertion orders and, eventually, to
media invoices. The nametftitle is
a brief description of the plan’s
objective, market, or product. It
appears on the printed media
plan, so clients see it.

Each print media plan is tracked
by a unique media plan number.
For easy tracking, each client has
it's own numbering sequence.

The media plan number is a
combination of the client account
number and its special media plan
number. A media plan’s number
can't be changed.

The print media plans kind
appears here for reference. Print
media plans can be created for
three kinds of periods: daily (for
newspapers), weekly (for weekly
newspapers, trade journals, and
weekly periodicals), and monthly
(for magazines). Daily print media
plans let you plan buys for a single
seven-day period. Weekly print
media plans let you buy space for
any twelve periods. Monthly print
media plans let you place ads for
up to twelve months.

10 A print media plan can be
marked as closed after its buys
have been ordered. Placing a print
media plan on-hold makes it
inactive, but keeps it open for
future use. Closed and on-hold
orders don't appear on media
status lists and traffic reports.

11 The campaign and budget are
displayed here for easy reference.
The optional budget can be used
to show the amount expected for
the total of the print media plan’s
space buys.

12 The media plan’s space buys
are listed here by publication
code. Double-clicking on a space
buy displays its complete details,
including the day, week, or month
in which the ads will run.

13 The pub code and publication
indicated the publication from
whom you're buying the space to
run the ad.

14 Market shows where the space
buy’s ads will run.

15 The ad number/caption
identifies the ad on the printed
media plan, insertions orders, and
media invoices. Any kind of
description text or ID code can be
used.

16 The ad’s gross cost (i.e., the
amount the client will pay,
including your commission)
appears here for reference. The
ad’s net cost will be calculated
using the gross cost and plan’s
media commission.

17 An optional status can be used
to track print media plans from
start to finish using the same
Status Table as jobs.

Print Media Plans
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Insertion/Broadcast/Interactive/Outdoor Orders
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Orders can be revised has many times as you want. To make the first revision and start
the revision counter, simply enter a “1” in the Description/Status window.

1 Use the previous and next
buttons to scroll through insertion
and broadcast orders.

2 Insertion and broadcast orders
can be easily added, cloned,
edited, or deleted. Click the add
button to add a new insertion
order. (To add a broadcast order,
go to Edit > Add > Broadcast
Order). Or click on the clone
button to make an exact copy of
an existing order. Click the edit
button to edit the order’s key
details, such as the vendor,
campaign, or brand. Click the

Insertion/Broadcast/Interactive/Outdoor Orders

delete button to delete an order.
Once an insertion or broadcast
order has been invoiced by the
vendor or pre-billed to the client it
can't be deleted—even if it was
only partially invoiced. Like jobs,
this feature prevents billable
orders from being inadvertently
deleted and, therefore, not billed.
Always let Clients & Profits X
automatically number the next
media order to avoid confusion
from using the numbers of deleted
orders over again.

3 Click the add buy button to add

new amounts to an order. The
remove buy button deletes one or
more selected costs from an order.
Only line items that haven't been
invoiced by the vendor or pre-
billed to the client can be deleted.
Once a line item is removed, it is
gone forever: its net cost and
gross amounts are deducted from
the job task permanently.
However, if needed, the same line
item can be added back to the
order later.

4 Any insertion or broadcast order
can be pre-billed using the pre-bill



Insertion orders and broadcast orders have separate preferences. The agency name, address, disclaimer,
auto-numbering, copies to names, and logo can be different. (This is especially useful for in-house
agencies that need to maintain a separate identity from the corporation in order to get agency discounts.)

button. Pre-billing automatically
creates an invoice for the order’s
gross amounts and shows the job
and task like any other invoice.
The pre-billing invoice is
unposted, so it can be proofed,
posted, and then printed with
other invoices. There are two
options available when pre-billing
an order. The show totals only
option combines all of the order’s
amounts together, so that the
invoice shows only one billing
amount. The show item-by-item
detail creates a separate billing
amount for every line item on the
order. Also, the order’s billing can
be added to an existing unposted
pre-billing invoice by entering the
number of the existing pre-billing
invoice into the pre-bill dialog box.

5 The print reports and print order
buttons are used to print insertion
and broadcast order reports and
forms.

6 If you know the insertion or
broadcast order number you want
to find, simply enter the number
into the find order field. Use the
find more link to find one or more
insertion or broadcast orders by
sequence, vendor, number, date,
or job.

7 The history pop-up menu can
be used to jump to a previously
viewed insertion or broadcast
order.

8 Use these links to edit the
order’s description/status, vendor
information, or options and to view
the vendor diary. The description/
status window can be used to edit
the order’s details, such as the

campaign, brand, or status. The
vendor information window can be
used to customize the vendor’s
name and address on this
insertion or broadcast order only.
The options window contains the
copies to names and disclaimer
for the insertion or broadcast
order. The vendor diary window
can be used to view, add, or edit
diary entries for the insertion or
broadcast order’s vendor.

9 Use the view>point pop-up
menu to view the order’s invoices.

10 Every order has a unique
number. New orders are numbered
automatically, but custom, user-
defined numbers can be entered
instead.

11 The order date is the date the
insertion or broadcast order was
added. The client number does
not show on the printed order;
there is an option in Preferences
to show the client name. The
ordered by field shows the initials
of the person who added the order.
Insertion and broadcast orders can
be printed in batches by user. The
amount is the total amount of the
order’s line items.

12 The vendor's name and
address are copied to the order,
but can be changed. This lets you
send an insertion or broadcast
order to a different address for the
same vendor. An order can
include only one vendor; if you're
buying something from multiple
vendors, each vendor gets its own
insertion or broadcast order.

13 The due date shows when the

buys are due to be delivered. The
balance amount shows the
amount remaining on the order
that has not been invoiced to
vendor invoices. When the
insertion or broadcast order is
closed, the balance amount will
automatically change to $0.00.

14 The order will be closed
automatically when applied to a
payable for the full balance due.
If an order needs to be closed for
any reason, click on the closed
box.

15 The insertion or broadcast
order’'s buys are listed here by line
number. Double-clicking on a
media buy opens the Edit Media
Buy window.

16 Some of the media buy’s
details are listed here for easy
reference. For insertion orders,
the media buy’s issue date, ad
size, ad#/caption, space close
date, materials due date, net cost,
and gross cost will appear. For
broadcast orders, the media buy’s
broadcast month, market, ad
name, product, materials due
date, net cost, and gross cost will
appear.

17 A lengthy description provides
a detailed explanation of the order
to the vendor.

18 Use the make goods link to
add a make good to this insertion
or broadcast order. Make goods
are compensation for ads that
either never ran or ran incorrectly.

19 The order’s current revision
number increments automatically

each time someone edits the
order. To start the automatic
revision numbering, a “1” must be
entered into the revision box in the
specifications window.

20 The status is user-defined
note that describes the order’s
current progress and appears on
the printed order. Insertion/
Broadcast Order reports can be
printed showing only orders with a
certain status (i.e., on-hold,
change order, etc.).

21 If an order has been approved,
the approver’s initials and date
appear on the Insertion/Broadcast
Order window. Once approved,
insertion and broadcast orders
can't be edited. Only the user
who approved the order can
unapprove the order.
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|eNnn Add Broadcast Order
Number: m ™ Blanket PO
Use templatet | None... |—H o
Vendor: f
o Order date: m Ordered by: | MGR Commission: | 0.00 ¢

O Job: Np_14p

Task:
Flight dates: _0 Campaign: o
Broadcast month: Brand: |
0 Ad name;
Market: Materials due: ] e

Product:

Desc:

Special Instructions:

Media Buyer OK:

@ Rep Instructions:
Media Rep OK:

PLEASE SICN AND RETURN OME COPY:

@ ( Cancel )(— e

Help

Radio, cable, and broadcast tv spots ordered on behalf of a client should be tracked with
broadcast orders. They can be created one-by-one or from broadcast media plans.

1 The number identifies a
broadcast order on windows,
reports, and forms. Broadcast
orders are numbered automatically
when added or when saved, based
on your preferences. Or, you can
number your orders manually.

2 Use the template pop-up menu
to select a template. Choosing a
template copies the template’s
default details to the new
broadcast order.

3 An order has only one vendor
which is usually the company that

Adding Broadcast Orders

owns the station (or it might be
the station itself). The vendor’s
name and address appear on the
printed broadcast order, but can
be customized on each order.

4 The order date is the date on
which the order was added. It
appears on the printed broadcast
order. Ordered by is the initials of
the person who added the
insertion order. Later, broadcast
orders can be printed in batches
by these ordered by initials. The
commission is copied from the
vendor, and is used to calculate

the buy’s net cost.

5 Every insertion order needs a
job and task for accurate cost
accounting. The broadcast order’s
cost will update the job task’s Net
POs total.

6 The flight dates are when the
programs will run.

7 Campaign and brand are
optional fields that are used by
media analysis reports.

8 The body of the broadcast order



Once the Add Broadcast Order window is saved, you can add media buys to the broad-
cast order. Media buys contain the specific details about each spot that will run on the
broadcast order. A separate media buy should be added for each combination of run
dates, times, and programs. A broadcast order can have dozens of media buys on it.

is completely customizable. The
standard field labels are designed
for broadcast orders. The default
labels are broadcast month, ad
name, market, and product.
Information added for these user-
fields appear on the printed
broadcast order.

9 The materials due date is used
by traffic reports and applies to
first spot on the broadcast order. It
can be customized for each media
buy.

10 The description field is a long
text block. The label itself is
customizable for flexibility. Any
kind of notes or details can be
entered here. This text appears in
the heading of the printed
broadcast order.

11 The special instructions field
provide a space for details. It
prints on the broadcast order
below the line items.

12 The Media Buyer and Media
Rep OK fields create approval
lines on the printed broadcast or
order along with the rep
instructions.

Adding Broadcast Orders

5-23



Adding Insertion Orders

8anNnn Add Print Insertion Order
Number: m
Use template: ' None... |=%i o : Blanket PO
Vendor: —r
Order date: | 08/24/04 | o Ordered by: 'MCR | e
Job: [TP-190 @
Task:
o Publication: Campaign: _67
Issue date: Brand:
o Ad#/caption: Space close: @
Ad size: Materials due: m
Ad name/size
Position:
Instr:ft!ifl:‘:: @
Gross cost:
Commission: ﬁ% @ m
Netcost [ | []Bill net, not gross
./-'_
@ ( Cancel ) (—m—]
help

Insertion orders are essential for accurate job costing. They allow media costs to be

committed to a job before the publication’s invoice is posted.

1 The order number identifies an
insertion order on windows,
reports, and forms. 10s are
numbered automatically when
added or when saved, based on
preferences, or manually.

2 Use the template pop-up menu
to select a template. Choosing a
template copies the template’s
default details to the new
broadcast order.

3 An |0 has only one vendor. It is
usually the company that owns
the publication (or it might be the

Adding Insertion Orders

publication itself).

4 The order date is the date on
which the insertion order was
added. It appears on the printed
insertion order.

5 Ordered by is the initials of the
person who added the insertion
order. Later, insertion orders can
be printed in batches by ordered
by initials.

6 Every insertion order needs a
job and task for accurate cost
accounting. The insertion’s cost

will update the job task’s Net POs
total.

7 The publication name is copied
from the Publications table, which
links the pub’s ad sizes with
insertion orders.

8 The campaign code can be
used to categorize media
expenses. The brand name helps
to identify the product line being
advertised. Both are optional.

9 The issue date shows the week,
month, or period of time each



Any kind of ad space ordered on behalf of a client should be tracked with insertion
orders. An insertion order can have one or dozens of different media buys for one vendor.
Each media buy can specify a different ad to run, another set of run dates, or a special
space buy for a certain ad and will appear as a separate line on the printed order.

media buy runs. The ad/caption
describes the specific advertise-
ment that’s being run for this
space buy. The ad name/size is a
combination of the ad/caption and
ad size fields, but can be
changed. It appears on media
billings.

10 Space close is the date on
which you must place this order
with the publication.

11 Materials due is the date on
which the ad’s film, disk, or other
materials must reach the
publication.

12 Position is a customizable text
field that can store notes or
special instructions that appear on
the printed insertion order.

13 Gross cost is the amount
you're charging the client for this
ad. The commission is copied
from the client, and is used to
calculate the ad’s net cost. Net
cost is the amount you'll pay the
publication for the ad.

14 The bill net, not gross option
lets you pass the ad’s true cost
along to the client, without any
agency commission.

Adding Insertion Orders
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enNn Add Interactive Order
Number: 30024 | o
Use template: ' Banner F’H o
0 Vendor: SECF | Security Fortress
o Order date: | 10/07/04 | Ordered by: [ja | e
Job: [TP-1984 BrightWaork
Task: |WEB Websiite/Interactive Media
o Website /Network : www._securityfortress.com Campaign: | Hixon
Run Dates : 1/2/05 - 1/31/05 Brand:  BrightWork 0
Ad#/caption @ BrightWork = Security Space Close : 11/30/04
Banner Size : 468x60 Materials Due : 12/20/04
Linking URL File Size : 48K m

o # Impressions /mo:

: | ads.brightwork.com/security

300000

Position top-right; weh page must not include ad banners from competitive products

Special
Instructions: @
Grosscost: 5450000 | oPM: $0.02
Commission: | 15.00 %
Met cost: W 2 Bill net, not gross m

@ ( Cancel )(—m—]

Help

Interactive orders can be used to buy advertising space on web sites, digital kiosks,
point-of-sale locations—anything that’s electronic.

Internet Advertising is are ads that
appears on websites. As the on-
line population rapidly grows, so
does the placement of ads on the
world wide web. One advantage it
has over traditional advertising is
that enables clients to interact
with the advertisement, so with a
mouseclick anyone on-line can get
more information about a product,
subscribe for news and updates,
or purchase it right then and
there.

1 The order number identifies an
interactive order on windows,

Adding Interactive Orders

reports, and forms. Orders are
numbered automatically when
added or when saved, based on
preferences, or manually.

2 Use the template pop-up menu
to select a template. Choosing a
template copies the template’s
default details to the new order.

3 An interactive order has only
one vendor, which is the company
that owns web site or network.

4 The order date is the date on
which the interactive order was

added and appears on the printed
order.

5 Ordered by is the initials of the
person who added the insertion
order. Later, orders can be printed
in batches by these initials.

6 Every interactive order needs a
job and task for accurate cost
accounting. The order’s cost will
update the job task’s Net POs
total.

7 The website/network name is
copied from the Publications/



Internet ads also provides advertisers with an opportunity to precisely target its audi-
ence, enabling them to deliver advertisements that are customized to each consumer’s

particular interests and tastes.

Media Companies table, which
links the media company’s ad
sizes with interactive orders. The
run dates show the days, weeks, or
months the interactive ad will
appear on the site. The ad/caption
describes the specific advertise-
ment that’s being run for this
space buy. The banner size is the
size of the ad in pixels. To see a
list of ad sizes, leave the banner
size empty then press tab. A
lookup list will appear listing the
media company’s ad sizes that
have been added into Publica-
tions/Media Companies table. You
can then choose an ad size from
the list or type in your own size.
The linking URL indicates to the
media company the web page
should be opened when a viewer
clicks on the ad.

8 The campaign code can be
used to categorize media

expenses. The brand name helps
to identify the product line being
advertised. Both are optional.

9 The # impressions shows the
number of time the ad will be
seen by readers per month. It is
used to calculate the ad’s cost per
thousand (CPM).

10 Space close is the date on
which you must place this order
with the media company.
Materials due is the date on which
the digital artwork must reach the
media company.

11 File size the media company
how large the digital artwork will
be when it is sent.

12 Use special instructions to
note any unique information or
specific details about how this
interactive ad should be run. They

appear on the printed interactive
order.

13 Gross cost is the amount
you're charging the client for this
ad. The commission is copied
from the client, and is used to
calculate the ad’s net cost. Net
cost is the amount you'll pay the
publication for the ad.

14 The bill net, not gross option
lets you pass the ad’s true cost
along to the client, without any
agency commission.

Adding Interactive Orders
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Adding Outdoor Orders

ann Add Outdoor Order
Number: 21038 | a
Use template: " Billboard |’3"] o
Vendor: GANNETT | Gannett Outdoor Media 9
o Order date: W Ordered by: j,A— e
Job:  HCC-203 Spanish Hills Golf & Country Club
Task: OUT Outdoor Media
0 Size/Number @ 4x40 Campaign: | Hixon |
Hluminated : Yes - dusk til 12am Brand: | Golf e

Type/Location | @ M122655 1-5 .7 mi NE |-8 5F Materials due: : | 10/22/04 o

Posting Date : 11/1/04
Space close: : 10/08/04 @

Special Instructions:  Rgplace "Join Now" deadline headline every week.

L]

Special charges: £ 1,850.00

| Flat paint - vinyls, extensions for
weekly headlines
@ Contract term: 12 month

Monthly rate: 12 500.00 @ @

Commission: = 1500 %

Total Net: § 129,072.50

[ Bill net, not gross m

Total Gross:  § 151,850.00

@ ( cancel | save )

Help

Outdoor media orders are used to place any kind of out-of-doors advertising, such as
billboards, mass transit signage, kiosks, building walls, and more.

Outdoor advertising can reach a
lot of people and build a strong
identity within a local market.

reports, and forms. Orders are added and appears on the printed
numbered automatically when order.
added or when saved, based on

Each board is assigned to a
location, which displays it's
message to a percentage of the
population. You can project your
message on one or huMmerous
boards, to reach a total number of
impressions that equal a
percentage of the area’s
population.

1 The order number identifies an
interactive order on windows,

Adding Outdoor Orders

preferences, or manually.

2 Use the template pop-up menu
to select a template. Choosing a
template copies the template’s
default details to the new order.

3 Each outdoor order has only
one vendor, which is the media
company that owns or manages
the billboard, signage, etc.

4 The order date is the date on
which the outdoor order was

5 Ordered by is the initials of the
person who added the outdoor
order. Later, orders can be printed
in batches by these initials.

6 Every outdoor order needs a job
and task for accurate cost
accounting. The order’s cost will
update the job task’s Net POs
total.

7 The size/number identifies the
specific ad space or location being



The outdoor locations you buy most often can be added to the Publications/Media
Companies table with specifications and rates, which will be copied to new outdoor

orders automatically.

ordered for this media buy. To see
a list of the media company'’s ad
sizes/numbers, leave the field
empty then press Tab.

Illuminated indicates whether the
outdoor advertisement is lighted
and, if so, how many hours it is lit.
The type/location describes the
specific location that this
advertisement will appear. Posting
date shows when the media
company will install or present the
outdoor ad.

8 The campaign code can be
used to categorize media
expenses. The brand name helps
to identify the product line being
advertised. Both are optional.

9 Materials due is the date on
which the digital artwork must
reach the media company.

10 Space close is the date on
which you must place this order
with the media company.

11 Use special instructions to
note any unique information or
specific details about how this
outdoor ad should be presented.
These notes appear on the printed
outdoor order.

12 Contact term tells the media
company how long (in months)
this outdoor ad will run. It is the
rate basis for the ad’s cost.

13 Monthly rate is the amount
you're charging the client for this
ad per month. The commission is
copied from the client, and is used
to calculate the ad’s net cost. Total
net is the amount you'll pay the
media company for the placement
for the full contract term. Total
gross is the total amount your

client will pay for the ad’s entire
run.

14 The bill net, not gross option
lets you pass the ad’s true cost
along to the client, without any
agency commission.

15 Special charges are optional
additional costs above and beyond
the outdoor ad'’s contract rate.
They are one-time charges that are
added to the total gross the client
will pay. Special charges are
commissionable, so the net charge
will be added to the orders't total
net.

Adding Outdoor Orders
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Media Traffic

:lala) Media Traffic

o W & @ e

Previous Week Next Week Print Report

show week: | 09/27/04 - 10/03/04 4] (3]

SPACE CLOSING

Date: Plan No.: Pub/Station: Description:
05/28/04 | CRK-001-B | WILB-FM
09/28/04 CRK-001-B WILB-FM
09/28/04 CRK-001-B WILB-FM

| Call media buyer before sending new ad copy

Call media buyer before sending new ad copy

09/30/04 | ABI-031-P | FINE | FP 4c right-side, front of book
09/30/04 ABI-031-P FOOD FP 4c right-side, front of book
10/01/04 | crk-001-B | WILB-FM | call media buyer before sending new ad copy

0

MATERIALS DUE

Due date: Client: Order#: Description:

05/29/04 AB| 20388 Grand Opening - FP, FC, outside back m
09/29/04  ABI | 20389 BUY NOW [ 1 pg 4C

09/29/04 | TP | 20393 | "Let us do the dishes" 3x5 BW POP

09/259/04 ITP 20353 “Let us dao the dishes" 3x5 BW POP

09/29/04 | ANN | 20309 | Football + Great Food - 2x10 ROP o

093/29/04 BAC 20341 Spend Thanksgiving w/US - 30" 2col .

09/29/04 | BAC | 20341 Spend Thanksgiving w/US - 30" 2col

09/25/04 | BAC 20341 | Spend Thanksgiving w/US - 307 2col .
09/29/04 | TP 20346 Turkey! Stuffing! Hike! 2x10 4c POP v

The Media Traffic window gives media planners and buyers a one-stop place to check
upcoming deadlines for space closings and materials due.

1 Use the prev week and next
week toolbar buttons to scroll

4 The space closing list shows
upcoming space deadlines from

5-30 Media Traffic

through the four weeks of media
deadlines available to be viewed.

2 To print a hard-copy printout of
the Media Traffic window, click on
the print report button.

3 The Media Traffic window can
list space closing and material due
dates for the next four weeks by
using the show week pop-up
menu. Only one week can be
viewed at a time.

broadcast and print media plans.
The space closing date can be
entered separately for each buy on
a media plan.

5 The materials due list shows
upcoming traffic deadlines from
actual insertion and broadcast
orders.
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Stations

Clients & Profits keeps a detailed table of the stations you use on broadcast media plans. A broadcast media plan is
composed of different spot buys for a two-week period. Each program/time is added as a separate spot buy on a broadcast
media plan, along with the number of spots that will run each day of the flight. When you’re adding a spot buy, you'll
select a station from the Stations lookup list—which links the media buy with the station’s programs, times, and rates.

T e —

Edit Delete :

Le® &

0

Add Print Add Edit Delete : Print Help
Show rates for: | Standard rates [ i o
| Station: Time/Program/Contract Rates: Rating: Gross Cost: |
© KFME KFMB TV 10-11A, Leeza 2.50 $ 100.00
| KNSD KNSD TV 11A-12N, Local News 3.50 3 200.00

12N-1P, Guiding Light

2.00

5 150.00

3-4P, Daily Kids Rotation

1.00

545.00

6-7P, World News/Rather

4.00

5 500.00

7-7-30A, CBS This Morning

2.50

5 100.00

7-7:30P, Seinfeld

3.50

$ 100.00

&-9A, Hang Time/Saved Bell

1.00

% 60.00

9-10A, Regis & Kathie Lee

3.50

5 200.00

5-32 Stations

The Stations window shows both your stations (television, radio, and cable) and their
programs/times. There’s no limit to how many stations and programs you can add.

1 Use the station toolbar buttons
to add, edit, and delete TV, radio,
and cable stations as well as print
a station list.

2 Use the time/program toolbar
buttons to add, edit, and delete
programs, times, and contract
rates for the currently selected
station. You can also print a list of
programs/times by clicking the
Print button.

3 Each station can have dozens
of different programs/times. You
can set up standard rates for each

program or time slot, as well as
special program/rate combinations
for each client. When a broadcast
media plan is created, the right
rate will be copied to the spot buy
automatically. Selecting a client
from the pop-up menu displays
that client’s special contract rates.
The program/times/rate table
needs to be frequently updated as
the rates and programs change.

4 Your stations are listed here,
sorted alphabetically. Clicking
once on a station displays its
programs/times and standard

rates. Double-clicking on a station
ID opens the Stations window,
where you can make changes to
its details.

5 The times/programs and
standard rates for the selected
station are listed here. Double-
clicking a time/program record
opens the Times/Programs/
Contract Rates window, where you
can change the spot’s details.



enNnnN Stations

Vendor: | MID

Midwest Television, Inc.

Station:

KFME @

Name: | KFMB TV

1200 Kearny Mesa Blvd

San Diego CA 92119

Stuart Jones

o Rep:

Phone:

615%/555-7855
Fax: £19/555-5641

Commission

15.00 % @

Note:

0

Market: _6

( Cancel ]E—m_)

Anyone using Clients & Profits can see and update the station’s information, including
the ad representative’s name, address, and phone number.

1 Each station must be
associated with a vendor in the
Vendor table. The vendor and the
station can be the same, but must
be added separately. One vendor
can have many stations.

2 The station code is used for
sorting and sub-totaling media
buys on reports and client
invoices, so clients will see it.
Each station code must be
unique. The code is customizable
and user-defined.

3 The station’s name and address
are entered here and appear on
printed media orders.

7 The publication’s market can
be entered here for future
reference.

4 An ad rep for the station can be
entered here with their phone
number, and fax number.

5 The commission rate will be
copied to broadcast media plans
when this station is used.

6 Any notes about the publication

can be entered here. They don't
appear on media reports.

Stations
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Publications/Media Companies

Clients & Profits X keeps a detailed listing of the publications you use for media print buying and media companies you use
for outdoor advertising. Each pub and media company belongs to a vendor in the Vendor table. One vendor can have
dozens of publications, each with its own collection of various ad sizes and rates.

enn Publications/Ad Sizes/Media Companies
2 3 — N
e Le® & @
Add  Edit Delete : Print Help |
Show rates for: | Standard rates Iv-$--! 0
J Pub Code: Publication Name: Ad Sizes: Gross Cost: |
SSoword . aDword 0 | Full page 5 1,000.00
| ADCP Ad Comp Publication Half page § 500.00
| ADPA ADPA | 1/4 page §250.00
AEC Journal AEC Journal back cover §120.00
| AEC Review AEC Review
| APPL APPL 6
Access | Access
| Adweek | Adweek o
Adobe Mag Adobe Magazine
| Adv Age Adv Age
| Airport News | Airport News
Amer Airways ﬁ.\mer Ajrways
| Amer Banker Amer Banker
| Architecture Architecture
Atlantic Mo. Atlantic Ma.
BTP | Big Town Paper
Bank Jaurnal Bank joumal‘

| Bank Systems
| Bank Tech News

Byte
| Byte
| Byte Buyer

C;AD Systems

Bank Systems
Bank Tech News
Byte
Byte
Byte Buyer

| CAD Systems

i

v

2
T —
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The Publications/Ad Sizes/Media Companies window shows a detailed listing of all the
publications and their ad sizes that you use for media print buying.

1 Use these toolbar buttons to
add, edit, and delete publications
as well as print a publication list.
Use these arrow toolbar buttons to
change the sort direction the
publications are listed in.

2 Use these toolbar buttons to
add, edit, and delete ad sizes and
contract rates for the currently
selected publication. You can also
print a list of ad sizes/rates by
clicking the print button. Use
these arrow toolbar buttons to
change the sort direction the ad
sizes are listed in.

Publications/Media Companies

3 A publication can have dozens
of ad sizes/rates. You can set up
standard rates for each ad size, as
well as special size/rate combina-
tions for each client. Selecting a
client from the pop-up menu
displays that client’s special
contract rates.

4 Your publications are listed
here, sorted alphabetically by
publication code. To sort the list
by publication name, click on the
publication heading. Clicking
once on a publication displays its

ad sizes and standard rates.
Double-clicking on a publication
opens the Publication window,
where you can make changes to
the publication’s information.

5 The ad sizes and standard rates
for the selected publication are
listed here by ad size. To sort the
list by gross cost, click on the
gross cost heading. Double-
clicking on an ad size opens the
Print Ad Size window, where you
can change the ad’s details.



enn

Edit Publication/Media Company

o Vendor ID:

AEC o

Pub Code: | AEC Review

Commission: | 15.00 % 0

Pub Name: | AEC Review

Address: | ATWOOD PUBLISHING

O (11827 WEST 112 THST

OVERLAND, K5 62210

Phone:  203-999-9691

Note:
Fax:  203-999-4782

Issue date: | ANMNUAL

o Close date:

Circulation:

Ad Rep: | JUDI SMITH

Address: | 365 JOHNSON AVE. #2K

HOUGHTON, CT 06111

Market:

( Cancel )( -ﬁw_:.a

Help

Anyone using Clients & Profits X can see and update the pub/media company’s informa-
tion, including the ad representative’s name, address, and phone number.

1 Each publication/media
company needs to be associated
with a vendor in the Vendor table.
The vendor and the publication/
media company can be the same,
but must be added separately.
One vendor can have many
publications.

2 The publication code is used for
sorting and sub-totaling media
buys on reports and client
invoices, so clients will see it.

Each publication code must be
unique. The code is customizable
and user-defined.

3 The commission rate will be
copied to media estimates and
print media plans when this
publication is used.

4 The publication and media
company’s name, address, phone
number, and fax number are
entered here and appear on
printed media orders.

5 The publication’s issue date,
close date, and circulation can be
entered here for future reference.

Publications/Media Companies

6 An ad rep for the publication
can be entered here with their
phone number. It is optional, but
appears on printed media orders.

7 The publication’s market can be
entered here for future reference.
The market is copied to orders
added for this publication or
media company.

8 Any notes about the publication

can be entered here. They don't
appear on media reports.
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Make Goods

Make goods are compensation for ads that either never ran or ran
incorrectly. There are many different ways a print ad or radio/tv spot can be
compromised, providing less value for your client. For example, you ordered
for a guaranteed position in a magazine, but the ad actually ran in a
different, less desirable place. Or, you placed a radio spot to air during a
certain show, but the ad ran during a different program. In these situations,
the publication or station will either offer to run the ad or spot again, credit
the entire amount of the

ad’s cost, or issue a partial

1 From the Insertion/Broadcast Orders window, find the broadcast order
that needs the make good.

2 Click once to highlight the media buy wasn’t run or run incorrectly.
3 Click the &3 add make goed link or choose Edit > Add Make Good.

The Add Broadcast Make
Good window opens,

Cl’edit. aialal Irserticn fBroadeast/Interactive 'Outdoor Orders A
9 deno T = o prompting you to enter the
Pl | o o make good’s details. The
Make goods need to be i = | =z ) , L
added to the original —— i = media buy’s details are
& dncif CHOUFSNNY Cos Cablbnciony o copied to the make good line

insertion order or broadcast

Broadcast §  Refer to approved calendar, OBB/CEE, 10w-30/game, 28 promo mentians 'wk

item except for the date,

order so that the shop’s job | i .

costing is accurate. If make wad ""'"":; 2 2] iy Ime, and program.

goods aren’t entered as they L e = BALANCE: _ £ 3,774.00

happen, your job costs + oued o oo e | et 30 [ a4 Enter the dates, days,

won’t match up with your : .: T ::.l."w.w | ves i t”?“e' and program for thCh

commitments e mie T3S0 maey 010 33563 1 this make good spot will run.

It's the media buyer's 1 e The dates, days, etc. is based

responsibility to match the the compensation negotiated

station’s affidavits or the with the station.

publication’s tear sheets to el | ( cancel ) (ES0)

verify that the ads or spots 5 Enter the rate, spots, _

that actually ran match & add mabe aoog e TR amounts, and other details
Revision: Oriy  Saus |n preduetion i for this make gOOd, then

what the shop ordered. Any

discrepancies needs to be

noted on the client’s

broadcast or insertion orders by adding
make goods.

Editing a broadcast media
buy. Broadcast orders are
added, edited, revised,
printed, and billed like
purchase orders and insertion
orders. Dozens of separate
media buys can be added for
the same station on a
broadcast order.

Make goods are simply additional media
buys appended to an insertion order or
broadcast order after the ads or spots
have been run. They're functionally no
different from an order’s regular media
buys—each make good line item includes
details about the dates, times, programs,
etc. of the affected print ad or radio/tv spot. Make goods will have a
negative cost amount if the station/publication is offering a credit;
otherwise, free make good ads will have a no cost at all.

When make goods are added, they update the job’s commitment totals just
like the original order. They appear on media reports just like other media
buys. When the station or publication media invoice is added into Accounts
Payable, they are reconciled along with the order’s original media buys.

To add a make good for a broadcast order

5-36 Make Goods

click Save.

To add a make good for an insertion order
1 Find the insertion order that needs the make good.

2 Click once to highlight the media buy wasn’t run or run incorrectly, then
click the &5 add make geod link or choose Edit > Add Make Good.

3 Enter the issue date, ad caption, and ad size for which this make good ad
will run, based the compensation negotiated with the publication.

4 Enter the space close and materials due dates for this make good, then
click Save.

Reprinting the revised broadcast or insertion order
Once the make good is saved, the broadcast or insertion order can be
reprinted and faxed to the station, if necessary. For clarity, the reprinted

order will show the original media buys plus the make goods.

1 Choose File > Print Orders then follow the prompts.



Media Billing Goals

The Media Group Performance - Trend Analysis report compares actual media spending for each kind of media (e.g.,
broadcast TV, radio, etc.) with the media department’s billing goals. For these reports to work properly, the shop’s billing
goals for each media kind must be entered in the Media Goals window. Media billing goals, which are based on gross
amounts on broadcast and print insertion orders, can be entered for each quarter of the calendar year.

Media Billing Goals

eﬁr‘"\
o

Print

Help

Media department billing goals (gross);

These goals are used on the media spending and analysis reports.

@ Media kind: 1@ 30: () 40
Broadeas 3000 $ 10,000 % 75,000 30,000 s $118,000
Cable TV $ 135,000 § 25,000 $ 65,000 $25,000 $ 250,000
e $ 90,000 $ 60,000 § 25,000 § 40,000 0
Newspaper $ 250,000 $ 350,000 $ 80,000 § 1,250,000
Magazine § 450,000 § 400,000 § 325,000 504,000, $ 1,679,000
Outdoor $ 10,000 $ 10,000 $ 10,000 $ 15,000 0
Interactive $ 50,000 $ 10,000 $ 10,000 $ 15,000
Other $2.500 $ 11,000 $ 25,000 $24,000) )
TOTAL $ 990,500 $ 876,000 $ 615,000 § 1,903,000  § 4,384,500

( cancel ) save )

These media billing goals can be edited any time. They are used only for media reports,
and don't affect job tickets, media plans or estimates, job costing, or the General Ledger.

The Media Billing Goals window
allows the agency to record media
spending goals per media type,
per fiscal quarter, and also
calculates a total for each media
type, quarter, and year-to-date. In
media analysis reports, these
amounts are measured against
actual gross amounts derived
from media spending.

1 Click print to get a report of the
year's billing goals by media kind
and quarter.

2 The media kind is used to
categorize different types of media
(e.g., tv, radio, newspaper, etc.)
and is a vendor setting. When
media performance reports are
printed (see Snapshots > Media),
C&P X will summarize media

Media Billing Goals

billings by vendor, sub-totaling by
the vendor’s media kind setting.

3 Enter the billing goals for each
kind of media for each quarter of
the year.

4 The quarterly and media kind

totals are calculated as you tab
between fields.
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Media Reports

Clients & Profits prints two kinds of media reports: status and traffic. Status
reports are used by media buyers and the media department to track open
media plans, media estimates, media deadlines, and unbilled media. Traffic
reports allow you to see the scheduled buys based on space closing and
materials due dates, which are entered for each line item on a media plan

or estimate.

To print media

m Any print or broadcast media plan that is marked as “closed” or
“inactive” will not be included on media status reports or media traffic
reports.

reports

eann Media Reports
Media reports can be ' @
printed from the Media Help
Estimates, Broadcast
Media Plans, or Print o Rapatiat Print media status reports:

Media Plans windows.

1 Choose File > Print
Media Reports.

Media reports are
grouped together by
category (i.e., Status or
Traffic). Each category
has a collection of
media reports that can
be printed. Only one
report can be printed
at a time.

2 Select a report

Status

From | date ordered: |3

to:

Traffic

..and for client:

Print report:

06/01/04

.07/a1/04

ALL

®) Media Estimate List

() Media Estimate Status Report
() Media Plan List

\:, Media Plan Status Report

() Client Media Calendar

() unbilled Media

Cancel 3

Print

category to show the
reports that can be
printed.

3 Choose a report by clicking on
a report name.

4 Enter a range of dates and
select any available options.

Status and traffic reports are
based on media plans and
media estimates, so the date
range entered will select
plans or estimates based on
the date they were added.

5 Click Print.
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Media Reports

Media reports help different
departments manage clients. Status
and traffic reports track the day-to-
day media plans and estimates.
Post-buy reports help media buys
track what's been ordered. Account
service can use client spending
reports to analyze each client’s
media spending. Group performance
reports summarize how well the
media department manages
spending trends, client media
profitability, and spending volumes.




Media Reports

Status Reports

Media Estimate List

The Media Estimate List lists all media estimates for a range of dates.

Media Estimate Status Report

The Media Estimate Status Report lists open media estimates sorted by status, which is user-
defined.

Media Plan List

The Media Plan List prints all broadcast media and print media plans for a range of dates.

Media Plan Status Report

The Media Plan Status Report lists open broadcast media and print media plans sorted by status,
which is user-defined.

Unbilled Media

The Unbilled Media Report lists all insertion orders and broadcast orders that have not been billed
to the client. The orders are grouped by client and sorted by order number.

Client Media Calendar

The Client Media Calendar lists media buys by billing period, which is based on your accounting
periods. Media buys are grouped by client, then subtotaled by month. The month’s media buys are
then sorted by close date and issue date. Each media buy shows its publication, issue date, ad
name, ad size, space closing date, and materials due date.

Traffic Reports

Space Closings

The Space Closings Reports lists the selected space closing dates of media estimate buys, sorted by
media buyer and date. It can be printed for planned or ordered media buys.

Material Due

The Materials Due Reports lists the selected material due dates of media estimate buys, sorted by
media buyer and date. It can be printed for planned or ordered media buys.

Media Job List

The Media Job List shows the job number, job name, AE, job due date, status, and status note for
each job with a media estimate, and sorts it by client.

Media Reports
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Media Link

The Media Link imports broadcast orders, print insertion orders, and vendor invoices into Client & Profits X from leading
media buying systems, including SmartPlus, TAPSCAN, Strata, and other systems that support the Standard Media Inter-

face. .
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Import Clear Log Print

Help

Ci cation:
e }"M!dhﬁrﬂrhrg’{ Preferences ] 0

pate  |OrderNo. User Status
OCT 2 2004 09:30:00 10301 JA ok
OCT 2 2004 09:30:00 10290 JA ok
OCT 2 2004 09:30:00 10302 JA ok
OCT 2 2004 09:30:00 10303 JA ok
OCT 2 2004 09:30:00 10304 JA Existing buy was updated o
OCT 2 2004 09:31:00 10305 JA Vendor CARE added
OCT 2 2004 09:31:00 10306 JA ok
OCT 2 2004 09:55:00 200336 JA ok
OCT 2 2004 09:55:00 200337 JA ok
OCT 2 2004 09:55:00 200338 JA ok
OCT 2 2004 09:56:00 200339 JA ok
OCT 2 2004 10:22:00 84766 JA This order was imported without a job number
OCT 2 2004 13:37:00 10305 JA ok
OCT 2 2004 13:37:00 10306 JA ok
OCT 2 2004 13:37:00 10307 JA ok
OCT 2 2004 13:37:00 10308 JA ok
OCT 2 2004 13:37:00 10309 JA ok
OCT 2 2004 14:30:00 4001 JA ok

Media Link imports broadcast orders, print insertion orders, and vendor invoices into
Clients & Profits from media buying system that support the Standard Media Interface.

Media buying systems that
support SMI export media orders
from media plans into specially-
formatted text files, one for each
broadcast order, insertion order, or
vendor invoice. These files the
order details (e.g., station ID, run
dates, number of spots, rating,
cost, etc.) or invoice needed by
Clients & Profits X for job costing,
billing, and media accounting.

How it works: A media buyer
enters broadcast orders, insertion
orders, and vendor invoices into
SmartPlus, TAPSCAN, or Strata.

The media buying system exports
a copy of the order or invoice into
a designated media_buys folder on
your file server. The Media Link
looks for these media buy files
then imports them into your C&P
X database as broadcast orders,
insertion orders, or vendor
invoices—ijust as if you'd typed
them in yourself. These orders can
be billed to clients just like any
other media order. Imported
invoices appear in Accounts
Payable.

1 Clicking import tells C&P X to
look for any export files inside the

media_buys folder then import
them.

2 Click the clear log button to
erase the Media Link activity log.
Clearing the log deletes the entries
permanently.

3 Click the print button to get a
hard-copy report of the Media
Link’s log entries.

4 The database name is shown
for reference. If you use multiple
databases, be sure to double-
check the database name—



Media Link really pays off when you’re buying large amounts of broadcast or print media.
Rekeying dozens of buys each week into Clients & Profits would be tedious and probably
error-prone. There’s no double-entry and no missing data.

otherwise you might import media
buys into the wrong database.

5 The Media Link Log tab
displays your recent activity. Each
time an order or invoice is
imported, a log entry is created.

6 The Preferences tab (see right)
offers settings and options that let
you control how some parts of

the Media Link will behave. These
settings let you turn on and off
certain functions.

7 For each imported order you'll
see the date/time it was imported,
the order number (as entered into
the media buying system), the
initials of the person who imported
the order, and the order’s import
status. The status notes any
problems with the imported media
order.

ann Media Link
; \ /B
® & @
Import : Clear Log :  Print Help

Database: Marketing C

| Media Link Log Fﬁ!f!m} a

Use BO commission from: (@) Strata

O Clients & Profits X

Use 10 commission from:  (®) Strata

() Clients & Profits X

Options: || Always bill broadcast arders at net, not gross o
[ Always bill insertion orders at net, nat gross

Enable log

o [ Notify when orders are imparted: 0

Name: | |.C. Johnson

E-mail:  jcjohnson@ad-agency.com

Media Link imports media buys from leading media buying systems, such as SmartPlus,
Strata, TAPSCAN, and other systems that support the Standard Media Interface.

1 Click the Preferences tab to
edit the Media Link’s options and
settings. The changes you make
are saved automatically and take
affect immediately.

2 Choose your media buying
system from the import media
buys from pop-up menu.

3 If you bill a different commis-
sion rate than that in your media
system, select “Clients & Profits”
from the use BO or I0 commission
from checkbox. This is usually
done if you bill at a lower

commission than the standard
15%. The gross amount will be
recalculated during the import
using the commission rate entered
in client’s Billing Info window.

4 |If your shop doesn’t charge
media commissions to clients,
check the always bill net option.
This forces all imported orders to
be billed at net cost instead of
gross cost. But make sure your
media buying system is not
already exporting at this lower
gross cost, otherwise you will
incorrectly reduce your billing

amount if you choose to use the
Clients & Profits commission rate.
If it is already exporting the gross
cost at the lower commission then
leave the setting at your media
buying system.

5 Uncheck the enable log option
if you don't need to record the
Media Link’s activity.

6 Use the notify option to send an
e-mail to any staff member (such
as a bookkeeper) whenever a new
order or invoice is imported
automatically.
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